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Trainer Notes Day 4  Agenda 
 

  Daily Diary, Email, Site of the Day 

  Diary Small Group/Whole Group Reflections 

  Cooperative Grouping Activity 
 

  Multimedia Technology  
 

  Whale – Animalia Lesson Plan 
 

          Comparing Whales 
 

          Assignments and Closing Remarks 
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Trainer Notes Day 4  Set-up Checklist 
 

 Check the following website for any resources, templates, etc. you may need to 
teach i3 training. http://www.i3forteachers.com/trainers/index.htm 

 Set up six computer stations for cooperative group rotations.  Place folders with 
assignments next to stations. 

 Send out email and site of the day to participants. 

 Check the Internet links that will be used for the day to make sure they are active. 

 Check the workstation desktops for the presence of the i3 participant folder. 

 Update and start the Day 4 Kiosk on the Trainers workstation. Kiosk update should 
include dates of trainings, time of classes, lunch break, other breaks, any other 
information that you want your participants to know. 

 Place stickies and pen at each workstation. 

 Place red cups at each work station – classroom management strategy. 

 Hang the Grouping charts. Set out the group folders. 

 Create a Shared folder on the server named after the groups. Lobster, Manatee… 

 Check paper and ink in printers. 

 Load music CD and have playing as participants arrive. 

 Assemble Sign-in sheets. 

 Hide whale cards under keyboards at each computer. Try and group so that each 
team has one of each whale card. 

 Start computers and test log-ins. Check headphones and microphones. 

 Have the Animalia book by Graeme Base ready. 

 Place one Discus Whales CD at each computer station. 

 The stations listed below should be set-up according to the directions.  The 
number of stations is dependent upon the number of groups in the training.  
Participant computer stations should be used. Each station will have a labeled 
folder with information about the activity (see below). These can be placed on 
top of monitors or to the side of the computer stations. 

 Station #1  
Scanner Station- You will need a scanner with scanner software installed. Check to 
make sure it is working. In the folder you will need step by step instructions for 
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how to use the scanner, participant checklist, and material that will be scanned. 
Scanned items come from A House for Hermit Crab by Eric Carle 

 Station #2 
Video Station- You will need a TV with a VCR for this station, the National 
Geographic Really Wild Animals, Deep Sea Dive video and an instruction sheet with 
the locations/segments of the material you want participants to view.  A factual 
whale book can also be included in the center.  Participants will use the fact book 
once they complete viewing the video segments. 

 Station #3 
Whales & Dolphins CD Station- Install this CD on the computer station you are 
using for this center. Check to make sure it works. In the folder you will have the 
Whales & Dolphins CD and instructions on how to start the software. 

 Station #4 
Encyclopedia Station- You will need access to any CD, server or Web based 
encyclopedia system. 

 Station #5 
TrackStar Station- Save the following link to the browser bookmarks and/or 
favorites. http://trackstar.hprtec.org/main/display.php3?track_id=143750 Create 
a folder in your favorites called “TrackStar” and save the link there.   Instructions 
on how to access the link in the folder are needed.    

 Station #6 
Hotlist Station- Save the following links to the browser bookmarks and/or 
favorites. Create a folder in your favorites called “Hotlists” and save the links 
there. Instructions on how to access the links in the folder are needed.    
http://www.kn.pacbell.com/wired/fil/pages/listseiwhalfl.html  
http://www.kn.pacbell.com/wired/fil/pages/listspermwhfl.html 
http://www.kn.pacbell.com/wired/fil/pages/listbluewhaho.html  
http://www.kn.pacbell.com/wired/fil/pages/listthebelufl.html 
http://www.kn.pacbell.com/wired/fil/pages/listthegrayfl.html  

 Station #7 
Camera Station- Access to a digital camera is needed for this station. Check to 
make sure it works; batteries; discs, etc.  Place folder with assignment next to 
station.  A floppy disc for each group is needed for them to save digital pictures. 
Label the disks 1-5 or one for each group.  

 Station #8 
Imagination Express Station- Imagination Express Oceans CD is needed for this 
station.   Place it in the folder. 
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Good Morning – Day 4 – page 1 
 
Trainer Notes – Daily Activities 
Participants work on their own when they arrive in class for approximately 20 minutes.  
From the kiosk they will get their morning assignments: 

Email activity – In addition to the email you will send the “Whale Comparison” 
template and the “Blank Kiosk Slide” to participants. These can be found in the 
Instructor Folder and on the trainer Web site. 
Daily diary reflection – Microsoft Word template 
Site of the day – found in email 
Use the student check sheet to check when assignments are complete.  Place work in 
folders. 

As participants finish the diary writing, they are to print two copies.  One is for the 
Trainer and one for their files.  Participants are to place yours in the group folder and 
check the task completed on the check-off sheet. 
Small Group / Whole Group Sharing of Daily Diary 

Move teams to small groups to discuss the diary reflection. 
Assign a leader of the group.  The leader will then report whole group.  Mark the 
leader on the Group Chart. 
Set a time limit for small group discussion. 
Trainer should walk from group to group listening to discussions and adding points. 
Small group leader will share responses with the whole group.   

Trainer Notes – Whole Group Sharing 
Daily Diary whole group sharing is an excellent time for the trainer to address 
concerns of the participants.  Be prepared to listen carefully and respond positively 
when necessary.  Don’t let this turn into a gripe session. 

Trainer Notes -  Site of the Day – 
Following the Diary discussion the trainer should show the whole group the site of the day 
and talk about the teaching and learning aspects of each one.   
**NOTE** At some point during your morning welcome, tell participants not to visit the 
BrainPOP site which is one of the sites of the day. There are restrictions based on the 
number of users per day so we will look at it as a whole group later.** 
Techie Talk -  

Email attachments 
o Attachment language is different depending on email software. 
o Usually an icon of a paper clip denotes attachments. 
o Attachments are used to share resources, send assignments to students, 

materials to parents, etc. 
o Walk through saving the attachment you sent in today’s email with the whole 

group. This process will be dependent on what email software is being used.  
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Good Morning & Welcome Back! 
Day 4 

 
You are on your own again this morning to complete the 
daily morning activities: diary writing, email and site of 
the day. 
 
1.  Open your diary template: 

Find the Training Resources folder on the 
desktop. 
Locate the Diary Template and double click on it to ope

h

Respond to the diary question in the slide show. 
Print 2 copies. Put one in your group folder and one in y

Save your document as “Day 4 Diary” in your folder. 
 
2.  Check your E-mail: 

Open Netscape or Internet Explorer. 
Click in the location box and type the following address
Enter) 
Click inside the Login Name box and key in your login na
Click inside the Password box and key in your password
Remember that your login name and password are writt
book. 
Click on Enter. 
Find the message from me, click on the underlined subj
Read and reply to my E-mail if necessary.  

 
3. View the “site of the day” How could you use this in your cl
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Cooperative Grouping Day - day 4 – Overview 
 
Trainer Notes:  Day 4 overview 
Day 4 is the cooperative grouping day where participants spend time in research centers 
or stations gathering facts and information about their assigned whale. The participants 
are separated into teams of 5. If you have participants from the same school, try and keep 
them grouped together. Each person on the team will gather research on one of the 
following 5 whales:  Beluga, Blue, Sperm, Gray and Sei.  Place a whale at each computer 
station before participants arrive in class. 
 
Activities for Day 4 come from the Whale Animalia Lesson Plan and the Comparing 
Whales Lesson Plan.  Instead of modeling each lesson separately they are merged 
together to create a set of activities that cover the most amount of information for the 
training day.  Therefore, Trainer notes for Day 4 are grouped together rather then with 
each individual lesson.  
 
During center/station time participants are using a variety of sources to gather 
information.  This information is used to create a multimedia slideshow with their 
cooperative group on Whales.  Individually, participants will use an Excel template to 
compare sizes of whales.  Below is an outline/timeline of the activities for the day. 
 
Day 4 Outline/Timeline 
• Begin the lesson with participants finding their whales. Place participants into teams 

and play the thumb game or play the “The Way You Move” video section to stress that 
success today is based on how well teams cooperate.  

• Participants need the data collection sheet on page 24. This is an individual activity 
that is modeled first by the instructor. This is a foundation building exercise for 
baseline knowledge on whales.  

o Participants insert the Discus Whales CD. 
o Help participants adjust sound or use headphones. Discuss headphone use.  
o Show participants how to navigate through the book by clicking on page corners 

and how clicking on words and pictures provide visual and auditory assistance.  
Click on the “Customize” menu and review book and system settings. Review Recall 
list and Teacher options 

o Allow participants a few minutes to answer question on their handout. 
o Quit Discus Books and pass in the CD’s.  
o Discuss what they learned about whales.  

• Introduce the Stations/centers to the participants. 
o Station #1  Scanner Station-. At this station you will be using a scanner to 

gather images for a Day 5 activity. You will be scanning images out of the book    
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Cooperative Grouping Day - day 4 – Overview 
 
A House for Hermit Crab by Eric Carle. In the folder you will find a chart with 
saving instructions. Tell participants that this is a “By Invitation Only” station. 
You will assign groups to this station to control the station flow and you will also 
provide group instruction on how to use the scanner. After the first scanner 
group is finished you will appoint one member from that group to train the next 
group. (Each one Teach one)  

o Station #2 Video Station- At this station you will be using the same video 
about water that we used on Day 1 except that it is segmented so that you are 
only watching portions about whales. Use the remote to find the right place on 
the tape and watch together as a group. This resource provides you visuals on 
whales and not as many facts as the other station resources.  One of the points 
of using the video is to see the whales swimming in their environment. Pay special 
attention to the whales interaction with humans.  When you are done with the 
video use the book for further factual information. 

o Station #3 Whales & Dolphins CD Station- At this station you will be using a 
CD resource to gather information about your whale.  

o Station #4 Encyclopedia Station- At this station you will be using a CD or Web 
based encyclopedia system (explain the resource that is being used). 

o Station #5 TrackStar Station- At this station you will be using a web-based 
activity that was designed for this lesson. The activity is a compilation of web 
sites and questions that will guide your research. You will find the link in you 
favorites or bookmarks. The tool that was used to build this is called TrackStar. 

o Station #6 Hotlist Station- - At this station you will be using a web-based 
activity that was designed for this lesson. The activity is a compilation of web 
sites and questions that will guide your research. Each Whale has it’s own Hot 
List.  You will find the link in you favorites or bookmarks. The tool that was used 
to build this is called Filimentality. 

o Station #7 Camera Station- At this station you need to take a digital picture 
of each group member and then a group picture.  The instructor or classmate can 
take the group picture.  All pictures must have a water theme. 

o Station #8 Imagination Express Station- At this station you will be using the 
same resource that you used on Day 3 - Imagination Express Oceans. Participants 
will use the Fact Book – Whales for researching. 

• Divide participants into their research groups. There are 2 options on how to create 
groups: 

• Option 1- the group of five persons that were created with whale cards – each having a 
different whale. They must go from station to station researching only one whale per 
station. This works well for team building, but is a problem when it comes to 
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Cooperative Grouping Day - day 4 – Overview 
 

participant involvement i.e. what do I do if we’re not looking up my whale?  
• Option 2- Participants with the same whales would be grouped. Higher level of 

participant engagement since they are all researching the same whale at a station. This 
option allows you to instruct teams to evaluate each of the stations and the content 
found there. They should ask:  What worked best? What didn’t?  How would students 
respond to the stations? With option 2 the digital camera station is not in the rotation 
due to the fact that the pictures will need to be of the 5 different whale groups. 
Option 2 requires you to find time to bring the original groups of 5 different whales 
back together so they can complete the camera assignment. Multiple cameras allows for 
several groups to take pictures at the same time. 

The following instructions are based on Option 2. 
• Have participants take out the handout on page 25. 
• Separate the class so that you have all the whales of the same type in groups.  
• Introduce the Whale Group Checklist.  Instruct a member of the team to check off a 

station after they have visited it.  
• Assign starting places for the groups and let them get started. This activity should 

take about an hour but depends on the size of the group. Plan for about 10-15 minutes 
per station.  

• As groups are rotating through the stations the trainer should visit each one multiple 
times to check on participants progress and to answer questions.  

• Wait for the first group to complete 2 stations and then invite them to the scanner and 
teach them how to use it. Trainer follows the instructions in the folder with the 
participants. Pick someone from this first group at the scanner to train the next group. 
This allows you to pace the training so that groups finish all stations around the same 
time.  

• Groups must visit all stations before going back to a station they have already been to.  
• If a group finishes before the others they can take their break and/or update the 

information on their Inspiration activity from day 1.  
• When all groups have completed the stations lead a discussion about resources used for 

the activity.  
o What was your favorite resource? Why?  
o What was easy to use? Why?  
o Which resource didn’t you like?  
o Which would have been the most beneficial to your students? Reading Level? 

Usability?  
• Part of successful integration is using the right tools for the right activity. This 

activity provides participants the ability to assess multiple resources for possible 
selection for curriculum use. 
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 Cooperative Grouping Day - day 4 – Overview 
 

• Participants now migrate (jigsaw) back to their original group of 5 – different whales.  
• Have participants take out the following handouts; Page 11, 12, 26 & 27 
• Participants are to each share their research on their individual whales.  All others 

record the information on page 27.  Participants now become knowledgeable on 5 
whales. 

• While groups are completing the above activity, choose groups to complete the digital 
camera station. 

o Assign one person from each group as the disk keeper. It will be their 
responsibility to save the pictures to the shared folder on the server. 

o Instruct them on saving to the server as a small group or individually. 
 
Trainer Notes – Comparing Whales activity 

When participants have finished the jigsaw activity they should pair with another 
person that has a different whale. The pair will complete the Venn diagram activity on 
page 26.  
Participants need pages 11 and 12 and pages 25, 26, 27 that were completed during the 
first portion of the lesson. 
Once the Venn diagram has been completed participants open the excel template on 
Whale Comparisons. 
Trainer will use the excel template to guide the whole group through a comparison of all 
researched whales.  You are discussing mathematically the information that was 
located. 

The Venn diagram and the Excel comparison activities are from the Comparing Whales 
lesson plan. They model how to use information gathered in cooperative groups to create 
products both whole group and individually. 
 
Trainer Notes – Small Group Activity – Whale of a Animalia Activity 
• Trainer is to read from the Graeme Base book Animailia.  

• Discuss Alliteration - Alliteration is the repetition of the beginning sound through a 
series of words.  Focusing on four part of speech:  nouns, adjectives, adverbs and 
verbs, participants, working in pairs, will work together to create a collection of 
nouns, adjectives, and adverbs that can be used to construct an original alliterative 
sentence.  

• Discuss the pictures in the book.  
• Explain that they will be creating something similar using the information they compiled 

on whales. This activity has participants use the research located during the 
cooperative grouping activity and the skills that were introduced on Day 3 for KidPix.   
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Cooperative Grouping Day - day 4 – Overview 
 

• For this activity participants are in the group with the five different whales.  Each 
individual is to use the information about his or her whale to create an alliteration. Each  
participant will create a slide about his or her whale using KidPix.   These will be shared 
with the group members and then all group alliterations will be pulled together into a 
slide show using KidPix. 

• Group members are to collaborate on the creation of each of the team member’s 
alliteration. First record words and then produce and share all alliterations on page 11 
and 12. 
 

Trainer Notes – Kid Pix activity 
• When alliterations are complete participants are to open KidPix software and create a 

slide.  They are using the skills learned on day 3.   They are to draw their whale and 
write their alliteration on the slide.  

• Review the draw tools, paint tools and color splash. Introduce background, sound and 
stamp tool.  

• Allow students enough time to create their slide. After about 5 minutes trainer should 
have participants save their slide into the shared folder on the server.  Do this 
together.  All slides need to be in the shared folder in order to build a slide show using 
all team members’ slides.  Remind participants to save periodically.  

• When individual slides are finished the groups break into teams of 2 and 3 to create 
the Title slide and the Credits slide. Participants must use the digital pictures that 
were taken earlier for both slides.  
 

Trainer Notes – Create a slide show in KidPix 
• Trainer has participants gather around 2 computers and takes them through the 

process of importing images into KidPix. 
o Move the cursor to the top of the page and click in the black area to reveal a 

hidden menu. Choose the add menu and then choose add a graphic. Navigate to 
the shared folder where the pictures were saved. This will be different 
depending on the location. Click on one of the graphics and add it to the slide. 
Demonstrate how it can be resized by dragging the corners.  

• Participants will save the slides in the same folder on the server where their individual 
slides have been saved.  

• Groups are to close KidPix on all machines except one. Each group is to gather around 
that workstation to compile the slide show in KidPix. 

• Click on the arrow in the bottom left had corner of the screen. This will take you to the 
slide show area. 
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Cooperative Grouping Day - day 4 – Overview 
 

• You will see numbered boxes. There are 96 boxes indicating that you can create up to 
96 slides. Click on the red arrow under the box numbered 1 to import a picture/slide in 
that spot. Choose the first slide to be imported. Import all group slides in any order.  

 
They can be easily moved into place by clicking-holding and dragging the slide into any 
location 
Click on the movie camera in the bottom right portion of the screen. This will enable 
the slide transition, timing and sound. 

• Sound- Click on the speaker icon in blue to show sound controls. You can play sounds, 
which were chosen as part of the slide when it was created, or you can record the text 
on the page while the slide is showing.  

• Timing- Click where it says 7 Sec this will allow you to adjust the time that the slide 
stays on the page.  

• Transition- Click on the red box between the slides. This will allow you to place 
transitions between slides. 

• When slide shows are completed save them in the same shared network folder and 
close out of KidPix. 

It’s show time! Present all slide shows on the main presentation system. Each 
group should present their show. 
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Planning, Producing and Assessing a Multimedia Project – 
Day 4 – page 2 

 
Trainer Notes – Use this page to discuss: 

What is multimedia? 
Multimedia hardware 
Multimedia authoring software 
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Multimedia Technology 
 
What is multimedia? 
Multimedia simply means being able to communicate in more than one way. Actually, working 
with multimedia is nothing new. Any time you use more than one method of communicating 
information, you are using multimedia. Computers are very good at mixing media. A typical 
multimedia presentation is one that includes several of the following elements: 
 

Text 
Graphics 
Sound 

Video (Animation) 
 
Multimedia Hardware: 
To create multimedia presentations, you will need a multimedia computer.  A typical 
multimedia computer includes the following components: 
 

Speakers 
Sound Card  

CD-ROM Drive 
Microphone 

 
If your budget permits, it is nice to have the following hardware accessories: 
 

Scanner  
Digital Camera 

 
A scanner allows you to scan pictures from a hard copy, and a camera allows you to take 
digital pictures that can be accessed directly by your computer. 
 
Multimedia Authoring Software: 

KidPix Studio 
HyperStudio 
PowerPoint 
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Planning, Producing and Assessing a Multimedia Project – 
Day 4 – page 3 

 
Trainer Notes – Use this page to discuss: 

Planning multimedia projects. 
Producing multimedia projects. 
Assessing multimedia projects. 
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Planning, Producing and Assessing a 
Multimedia Project 

 
Planning 
Multimedia projects usually take longer to complete than traditional projects; therefore, 
proper planning is a must. Consider the following: 

 
• What type of multimedia slide show will your students complete? (Alphabet, Animals, 

My favorite..., All about me, 100 slide show, Research Report, Science Concepts, Class 
slide show for Open House) 

 
• How will you group your students?  You may want to start small.  A whole group class 

slide show in which each student contributes one slide is a manageable beginning for 
first time student and (and teacher) users. As you and your students become more 
comfortable with the program, you will want to explore small group projects. Each 
group will produce a slide show about a chosen topic, which supports the current unit of 
study (such as plants and animals native to a habitat). Showcase the talents of your 
students by allowing them to present their multimedia slide shows to the entire class! 
Individual projects may include book reports, book reviews, science or social studies 
projects, and demonstration of math concepts. The possibilities are endless. 

 
• How much time will you allow for this activity? Will the students rotate through the 

classroom computer? Will the lab be available for use? 
 

• How will your students plan? What storyboards, or planning and organizing tools will 
they need? 
 

Producing 
Discuss the following production tips with your students: 

• Illustrations should be large and colorful! 
• Text should be large and easy to read. 
• Be creative! Use only a few stamps! Original artwork is very COOL! 
• Speak slowly and clearly when recording sound. Play an audio CD softly in the 

background during the slide show.  
 

Assessing 
It is important to consider your standards and learning objectives carefully when planning 
a multimedia project. When you consider your content area standards (science, for 
example) along with language arts/writing, you will be surprised at how many lesson 
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Planning, Producing and Assessing a Multimedia 
Project – Continued – Day 4 - page 4 

 
Trainer Notes – Continuation of discussion points on assessing a multimedia project. 
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objectives your students will meet during the project. When planning for assessment, 
consider the following ideas:  

 
Planning: 

• Did the student complete a storyboard? 
• Did a peer editor or teacher approve the draft before the 

student went to the computer? 
 

Content: 
• Were the QCC standards met? Was there sufficient content in the project? 

Was it accurate?  Was it organized? 
 

Mechanics: 
• Was the slide show edited for correct grammar, spelling, capitalization, and 

punctuation? 
 

Creativity: 
• Did the slide show include a beginning and ending slide? 
• Did the artwork and stamps support the topic of the slide? 
• Did the slide show demonstrate creativity and originality? 
• Did the sound in the slide show appropriately enhance the presentation? 
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Whale – Animalia Lesson Plan - day 4 – page 5 
 
Trainer Notes – Whale – Animalia lesson plan  
For the purpose of Day 4 training the Whale-Animalia Lesson Plan and the Comparing 
Whales Lesson have been combined.  Trainers should follow the training steps are the 
pages preceding this lesson.   
 
Trainers should read through the lesson plan for understanding and resources. 
 
Teachers may choose to use portions of this lesson in the classroom.   
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Whale-Animalia Lesson Plan 
Teaching 
Strategies 
Modeled 

Technology 
Strategies 
Modeled 

Instruction 
Essential Questions for Teachers: How do I gather information from the 
Internet?  How do I create a KidPix slideshow? 

 

Copyright  2003  i3 Inc.                                          inspiring, innovative, integration                                                       Day 4                     
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Essential Question: What are some of the various types of 
whales and what do they have in common?   
 
Learning Standards (State of Michigan): 
Assessed:  
English Language Arts Standard 3: Later Elementary  
Integrate listening, speaking, viewing, reading, and writing skills 
for multiple purposes and in varied contexts.  
 
English Language Arts Standard 3: Early Elementary  
Integrate listening, speaking, viewing, reading, and writing skills 
for multiple purposes and in varied contexts. Examples include 
using more than one of the language arts to create a story, write 
a poem or letter, or to prepare and present a unit project on 
their community. 
 
Science Standard I.1:Elementary 
Develop strategies and skills for information gathering and 
problem solving. ( Tools: Sources of information, such as 
reference books, trade books, periodicals. Real-world contexts: 
Seeking help from peers, adults, libraries, other resources.) 
 
Science Standard I.1: Elementary 
Develop strategies and skills for information gathering and 
problem solving.  
(Tools: Sources of information, such as reference books, trade 
books, periodicals. Real-world contexts: Seeking help from peers, 
adults, libraries, other resources.) 
 
Materials: Student reproducibles, Whale CD’s, Internet 
connection, word processing software, Animalia by Graeme Base, 
Kid Pix Studio Storyboards 
 
Technology Connections: Students will gather information from 
the Internet and CD roms on an assigned whale. They will create 
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Teaching 
Strategies 
Modeled 
 
 
 
Whole 
Group 
Instruction 
 
 
Individual 
Work 
 
 
 
 
 
 
 
Peer Editing 
 
 
Individual 
Work 
 
 
 
 
 
 
Whole 
Group 
 
 
 
Whole 
Group 
 
 
 
Small 
Groups- 
Learning 
Stations 
 
 
 
 
 
 
 

Technology 
Strategies 
Modeled 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
KidPix Studio 
 
Ideas for 
using KidPix 
Slide Show in 
the 
classroom- 
http://course
web.tac.unt.e
du/rhondac/K
idPix.htm 
 
 
 
 
 
Internet 
Whales CD 
Encarta CD 
Whales Video 
Imagination 
Express: 
Oceans 
 
 
 
 
 
 
 

an alliteration with their group and publish a multimedia show 
using KidPix. 
 
Procedures: 
  Individual Activity: 

• Read Animalia by Graeme Base to the whole group.   
• Discuss parts of speech and alliteration found in 

Animalia. 
• Each student will write and illustrate a sentence which 

includes age-appropriate parts of speech - adjectives, 
nouns, verbs, and adverbs, as well as alliteration.  The 
sentence should be about the whale they have been 
assigned.    

• Students will use a storyboard to plan a slide for their 
whale. 

• Students will use peer editors to check for grammar, 
parts of speech, alliteration and mechanics. 

• Students will use Kid Pix Studio and their storyboards 
to create a slide.  This may be done during learning 
centers, in the computer lab, or individually during class 
time. 

• The teacher will compile all slides into a class slide 
show. 

• The whole class will view the completed slide show. 
 

  Small Group Activity: 
• Read Animalia by Graeme Base to the whole group.   
• Discuss parts of speech and alliteration found in 

Animalia. 
• Divide class into five collaborative learning groups. 

Have the groups rotate to the following five stations: 
Station 1: Internet Hotlist 
Station 2:  Whales CD 
Station 3:  Encarta 
Station 4:  Whales Video 
Station 5:  Imagination Express: Oceans 

 
• The groups will rotate to each station. They should 

locate one of the team member’s whale at each station. 
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Teaching 
Strategies 
Modeled 
 
How to use 
Learning 
Stations in 
your 
classroom- 
http://www.
essdack.org/
stations/  
Small Group 
 
 
 

Technology 
Strategies 
Modeled 
 
 
KidPix Studio 

Observe a picture of the animal, describe the picture, 
and categorize the words as nouns, verbs, adjectives, 
and adverbs. As a group, write an alliteration sentence 
for each whale.  

• As a whole group, teach students how to use the basic 
Kid Pix Studio tools. 

• Each student will create and save their own alliteration 
slide to a disk. 

• Each collaborative learning group will create a slide 
show with includes the team members’ individual slides 
along with a title slide and an ending slide. 

Assessment:  
Grades 3-5: Students will be assessed using the 
multimedia rubric. 
Grades K-2: Students will be assessed using the 
multimedia rubric. 
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Animalia Slide Show Student Self-Assessment 
 

Name Date  
 

 
Use the following scale to see how well you did on your slide: 

 
Empty Bag - I did not complete the slide. 
Cookie Crumbs - I did not give this slide very much attention. There is a lot of room for 
improvement. 
Broken Oreo - This slide is not quite an Oreo. I tried to follow the directions and work 
neatly, but I know this is not my best effort. This slide could have been better. 
Oreo - I followed all of the directions. It is done neatly. It is my best effort, and I am 
proud of my work. 
Frosted Oreo - Everything is an Oreo AND I added something extra special. 
 
 
My slide was about a whale. 
Empty Bag    Cookie Crumbs     Broken Oreo     Oreo  Frosted Oreo 
 
My slide demonstrated alliteration. 
Empty Bag    Cookie Crumbs     Broken Oreo     Oreo  Frosted Oreo 
 
My slide included adjectives, nouns, and verbs. 
Empty Bag    Cookie Crumbs     Broken Oreo     Oreo  Frosted Oreo 
 
My slide was edited for correct use of capitalization, punctuation, and spelling. 
Empty Bag    Cookie Crumbs     Broken Oreo     Oreo  Frosted Oreo 
 
My slide show illustrations showed detail and creativity. 
Empty Bag    Cookie Crumbs     Broken Oreo     Oreo  Frosted Oreo 
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Animalia Slide Show Teacher Assessment 

 
Name Date  

 
Use the following scale to see how well you did on your slide: 

 
Empty Bag - I did not complete the slide. 
Cookie Crumbs - I did not give this slide very much attention. There is a lot of room for 
improvement. 
Broken Oreo - This slide is not quite an Oreo. I tried to follow the directions and work 
neatly, but I know this is not my best effort. This slide could have been better. 
Oreo - I followed all of the directions. It is done neatly. It is my best effort, and I am 
proud of my work. 
Frosted Oreo - Everything is an Oreo AND I added something extra special. 
 
 
The slide was about a whale. 
Empty Bag    Cookie Crumbs     Broken Oreo     Oreo  Frosted Oreo 
 
The slide demonstrated alliteration. 
Empty Bag    Cookie Crumbs     Broken Oreo     Oreo  Frosted Oreo 
 
The slide included adjectives, nouns, and verbs. 
Empty Bag    Cookie Crumbs     Broken Oreo     Oreo  Frosted Oreo 
 
The slide was edited for correct use of capitalization, punctuation, and spelling. 
Empty Bag    Cookie Crumbs     Broken Oreo     Oreo  Frosted Oreo 
 
The slide show illustrations showed detail and creativity. 
Empty Bag    Cookie Crumbs     Broken Oreo     Oreo  Frosted Oreo 
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Alliteration Words 

 
Type of Whale___________________________ My Letter___________ 
 
Nouns Verbs Adjectives Adverbs 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

   

 
My whale alliteration ___________________________________________________ 

 
___________________________________________________________________ 
 
___________________________________________________________________
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Team Member Alliterations 

 
Whale Type ____________________________ 
 
Alliteration __________________________________________________________ 
 
___________________________________________________________________ 
 
___________________________________________________________________ 
 

 
Whale Type ____________________________ 
 
Alliteration __________________________________________________________ 
 
___________________________________________________________________ 
 
___________________________________________________________________ 
 

 
Whale Type ____________________________ 
 
Alliteration __________________________________________________________ 
 
___________________________________________________________________ 
 
___________________________________________________________________ 
 

 
Whale Type ____________________________ 
 
Alliteration __________________________________________________________ 
 
___________________________________________________________________ 
 
___________________________________________________________________ 
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Whale Alliteration Slide Show 
Kid Pix Studio Deluxe Steps 

 
Getting Started: 
1.  Have a blank floppy disk prepared on which to save slides. 
 
2.  Open Kid Pix Studio Deluxe.  From the Picker menu, choose Kid Pix. 
  
Slide 1 - Title Slide: 
 
1.  Add a background: 

• Click the Paint Bucket Tool.  Select a color from the Color Palette.  Select a 
pattern from the Options Tray.   Move the Paint Bucket onto the page and click. 

 
2. Add a title: “A Whale of a Time” 
• Click the Typewriter Tool.  Select a font, size, and style from the Options Tray.  Scroll 

to choose a font, or double-click the font window to choose a font from a list.  Select a 
color from the Color Palette.  Click to plant the cursor on the screen.  Begin typing.   

 
3.   Editable text is a new feature available in Kid Pix Studio Deluxe.  Text boxes float 

above the background, making them easy to edit and move.  Simply click the Typewriter 
Tool, then click to select a text box.  You may now change the font, size, color, etc. or 
move the text box by clicking and dragging.  To edit text, click to plant the cursor.  
Then backspace over text to remove letters or words.  Type to add text.  It’s that 
easy!   

 
4. If you are NOT using the Deluxe version of Kid Pix Studio, you do NOT have editable 

text boxes.  Follow the steps below to center the title. 
 

5.  Center the title: 
• Click the Moving Van Tool.  Click the Magnet in the Options Tray.  Your cursor 

will become a +.  Move the + to the upper left portion of the title.  Click, hold and 
drag to select the title.  You will see marching ants around the title.  Click in the 
middle of the title (you will see the magnet), hold and drag the title until it 
appears centered.  Follow the same procedure to center any other text.   

 
6.  Fill in white spaces: 
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• Click the Eyedropper Tool.  Move the Eyedropper onto the background and click.  

This tool picks up the exact color of the background.  Now click the Paint Bucket.  
Move the Paint Bucket to white areas and click to fill with background color. 

 
7.  Add a second row of text:  By _________ 

• Click to plant the cursor in the desired location on the screen.  Choose a font, 
size, color and style.  Begin typing. 

 
8.  Resize text boxes: 

• Click one of the red handlebars on the text box.  Click, hold, and drag to resize. 
 

9. Hear text read aloud: 
• Under the Speech Menu, choose Read Text Aloud.  (This feature will not work if 

text is painted to the background.) 
 
• If a word is mispronounced, you may edit the speech by choosing How to 

Pronounce from the Speech Menu. 
 
10.  Paint text to background: 

• Text boxes float above the background.  You may choose to affix the text boxes 
to the background .  Click the Typewriter Tool.  Under the Toolbox Menu, choose 
Paint Text to Background.  You may paint only the active text box, or all text 
boxes to the background.  When you paint the text to the background, it may no 
longer be edited!!  In addition, if text is painted onto the background, it may not 
be read aloud! 

 
11.  Record a sound: 

• Under the Goodies Menu, choose Record a Sound.  Click the Record Button.  
Record your text for the title slide.  Click the Stop Button.  Click the Play Button 
to preview the recording.  Click Save. 

 
 

12.  Decorate the title page: 
• Click the Rubber Stamp Tool.  Under the Goodies menu, pull down to Pick a Stamp 

Set.  Scroll down until you see the Nature stamp set.  Click to choose the Nature 
stamp set.  Click OK. 
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• Scroll through the Options Tray to find stamps of ocean animals.  Click to select 
the stamp you wish to use.  Your cursor will become the stamp.  Move the stamp 
onto the page in the desired location.  Click to place stamp.   

 
13.  Enlarge stamps: 

• Press the Control key to make the stamp one size larger.  While the Control key 
is pressed down, click to stamp. 

• Press Control and Shift to make the stamp even larger.  Click to stamp while 
holding down Control and Shift. 

 
14.  Edit a stamp: 

• Click to select the stamp you wish to edit.  Under the Toolbox menu, click Edit A 
Stamp.  You may flip the stamp, draw on it, paint it a different color, etc.  When 
you are finished editing, click OK.  Click to stamp.  When you are finished with 
that stamp, go back to Edit A Stamp under the Toolbox menu.  Click Restore 
Original to restore the stamp to its original position and color.  Click OK.  You 
may also double-click the stamp in the Options Tray to access the stamp editor. 

 
15.  Save slide 1: 

• Select Save a Picture under the File menu.  Choose a location in which to save.  
(floppy disk - A drive)  Name your picture (slide1).  Select Save Sound.  Click OK. 

 
Slide 2: 
 
1.  Add a new page: 

• Choose New from the File menu. 
 

2.  Add a background:   
• Click the Paint Bucket Tool.  Select a color from the Color Palette.  Select a 

pattern from the Options Tray.   Move the Paint Bucket onto the page and click. 
 
3.  Draw a picture: 

• Use the Pencil Tool to draw a picture on the page.  Notice you have two Option 
Trays - one has a blunt pencil point, one has a rounded pencil point. Make sure all 
lines are connected.  Fill your picture using the Paint Bucket. 

 
4.  Erase: 

• Use the Eraser Tool’s first four options to erase small mistakes.   
• The remaining options in the Options Tray will erase the entire page.   
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5.  Undo: 

• Click the Undo Man to undo your last operation if you make a big mistake.   
 

6.  Add text:   
• Click the Typewriter Tool.  Select a font, size, and style from the Options Tray.  

Scroll to choose a font, or double-click the font window to choose a font from a 
list.  Select a color from the Color Palette.  Click to plant the cursor on the 
screen.  Begin typing.   

 
7.  Record a sound: 

• Under the Goodies Menu, choose Record Sound.  Click the Record Button.  Record 
your text for the title slide.  Click the Stop Button.  Click the Play Button to 
preview the recording.  Click Save. 

 
8.  Save slide 2: 

• Select Save a Picture under the File menu.  Choose a location in which to save.  
(floppy disk - A drive)  Name your picture (slide2).  Select Save Sound.  Click OK. 

 
Slide 3: 
 
1.  Add a new page: 

• Choose New from the File menu. 
 
2.  Insert a graphic from an outside source: 

• From the File Menu, choose Import a Graphic. 
• Find a graphic that you wish to use.   
• You will see a preview of the graphic on the left side of the Import a Graphic 

window.  You may rotate the graphic by clicking the rotate arrows below the 
graphic preview. 

• Choose to position the graphic on the drawing area by selecting one of the 
following options: 
 Fill Screen will make the graphic fill the entire drawing area   
 (picture may get distorted). 
 Scale to Fit will make the graphic fit the drawing area    
 proportionally. 
 Center will place the graphic in the middle of the drawing area.  It  
 will appear in its original size. 
 Upper Left will place the graphic in the upper left corner of the  
 drawing area.  The graphic will appear in its original size. 

Day 4                                                        inspiring, innovative, integration                                          Copyright  2003  i3 Inc. 
 



Curriculum and Technology Integration Training                                                  Trainers Manual  
 

Whale Alliteration Slide Show – day 4 – page 17 
 

Trainer Notes – Step by step instructions for creating a slide show in KidPix. 

i3 Inc. – Inspiring Innovative Integration                                                                    Copyright  2003  i3 Inc. 



Water, Water Everywhere!                - 17 - 
Curriculum & Technology Integration Training  
   

 Scale Manually will enable you to move and resize the graphic by  
 hand. 
 
* Scale manually is an option available only in Kid Pix Studio Deluxe. 

 
• Choose Scale Manually.  Click OK. 
• Move the graphic by clicking, holding, and dragging from the center of the 

graphic.   
• Resize the graphic by clicking, holding, and dragging from one of the blue 

handlebars.  Drag inward to reduce the size of the graphic.  Drag outward to 
increase the size of the graphic. 

• Position the graphic.  Click outside the graphic area to place graphic on page. 
 
3.  Select a background color: 

• Choose the Eyedropper Tool.   Click a desired color on the graphic to choose a 
background color.  This places the desired color on the Color Palette. 

 
4.  Add a background: 

• Choose the Paint Bucket Tool.  Your selected color should be on the Color Palette.  
Click to paint the background. 

• Some graphics may have a white border around them.  If this is the case, you 
may use the Paint Bucket Tool to fill in the white border.  Occasionally, paint will 
bleed into your graphic.   You may choose to frame the graphic.  Choose the 
Rectangle Tool, and the Transparent Option in the Options Tray.  (Transparent 
Option is the third one from the left.)  Click, hold, and drag to draw a rectangle 
around the graphic.   

 
5.  Add text:   

• Click the Typewriter Tool.  Select a font, size, and style from the Options Tray.  
Scroll to choose a font, or double-click the font window to choose a font from a 
list.  Select a color from the Color Palette.  Click to plant the cursor on the 
screen.  Begin typing.   

 
6.  Record a sound: 

• Under the Goodies Menu, choose Record a Sound.  Click the Record Button.  
Record your text for the title slide.  Click the Stop Button.  Click the Play Button 
to preview the recording.  Click Save. 

 
7.  Save slide 3: 
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• Select Save a Picture under the File menu.  Choose a location in which to save.  

(floppy disk - A drive)  Name your picture (slide3).  Select Save Sound.  Click OK. 
Slide 4: 
 
1.  Add a new page: 

• Choose New from the File menu. 
• Add content 

 
4.  Record a sound: 

• Under the Goodies Menu, choose Record a Sound.  Click the Record Button.  
Record your text for the title slide.  Click the Stop Button.  Click the Play Button 
to preview the recording.  Click Save. 

 
5.  Save slide 4: 

• Select Save a Picture under the File menu.  Choose a location in which to save.  
(floppy disk - A drive)  Name your picture (slide4).  Select Save Sound. Click OK. 

 
Pulling slides into a slide show: 
 
1.  Insert the slides 

• Under the File menu, choose Return to Picker. 
• Click SlideShow. 
• In the first moving van, click the picture button (lower left, beside the music 

note).   
• Insert slide one.  Directories: A drive.  Files:  slide1.  Click slide1.bmp.  Click OK. 
• Insert slide two.  Click the picture button on the second moving van.  Click 

slide2.bmp.  Click OK. 
• Insert slide three.  Click the picture button on the third moving van.  Click 

slide3.bmp.  Click OK. 
• Insert slide four.  Click the picture button on the fourth moving van.  Click 

slide4.bmp.  Click OK. 
 
2.  Choose or add sound: 

• Click the music button on the first moving van.  
• Choose a sound.   

The black box contains Kid Pix sounds. 
The abc option selects the computer voice to read story to you.   
 (Available only in Kid Pix Studio Deluxe.)  
The Kid Pix option selects a sound you recorded while in Kid Pix. 

Day 4                                                        inspiring, innovative, integration                                          Copyright  2003  i3 Inc. 
 



Curriculum and Technology Integration Training                                                  Trainers Manual  
 

Whale Alliteration Slide Show – day 4 – page 19 
 

Trainer Notes – Step by step instructions for creating a slide show in KidPix. 

i3 Inc. – Inspiring Innovative Integration                                                                    Copyright  2003  i3 Inc. 



Water, Water Everywhere!                - 19 - 
Curriculum & Technology Integration Training  
   

The microphone option enables you to record a sound now. You have 16 seconds 
for a recorded sound. You may choose More Sounds to access .wav files and 
import a sound. You may choose no sound. 

• Click Select. 
• Follow the above steps to add sound to remaining slides. 
 

3.  Add transition: 
• Click the transition button to the right of the music note.   
• Click to select a transition. 
• Click preview to view the transition. 
• Click Select. 
• Follow the above steps to add transitions to remaining slides. 

 
4.  Add a second sound to the ending slide: 

• On slide four, record a sound “The End.” 
• Choose a scissors transition. 
• For the fifth moving van, import slide four again.   
• Choose a different sound for this slide - hands clapping, for example. 
• When the slide show plays, you will hear “The End” followed by applause. 
 

5.  View or change time for each slide: 
• Click and hold the gray button on the time slide bar to view the current time 

elapsed for that slide.  The time slide bar is below the truck.  Click the gray 
button to the right of the yellow mark. 

• Click and drag the gray button to increase or decrease the time for each slide.  
Slide will play for at least the length of the time the sound plays, with a 
maximum of 30 seconds per slide. 

 
6.  Rearrange slides: 

• Click and drag the moving van to the desired location to rearrange slides. 
 

7.  Delete a slide: 
• Click to select the slide you wish to delete.   
• Click the dynamite. 
 

8.  Undo your last operation: 
• Click the undo man immediately. 
 

9.  View slide show: 
• Click the triangle button at the bottom of the screen to view the slide show once.  
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• Click the boxed triangle to play the slide show looped.  Double click to stop the 

looped slide show. 
 

10.  Save slide show: 
• File menu - Save a Slide Show - make sure Kid Pix pictures (.bmp files) and 

slide show are saved in the same location.  You will need Kid Pix Studio 
software to run this slide show.  This saving option enables you to edit the slide 
show. 

• File menu - Save an AVI - saves your slide show as a movie file which may be 
viewed in Wacky TV. 

• File menu - Save a StandAlone - saves your slide show by itself.  It saves the 
slide show as an executable file, with a .exe extension.  It will run without Kid Pix 
Studio software; however, you will not be able to edit. 
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Comparing Whales 
Teaching 
Strategies 
Modeled 

Technology 
Strategies 
Modeled 

Instruction 
Essential Questions for Teachers:  How do I use a multimedia CD in my 
classroom?  How do I use Excel?  How do I create a slideshow in KidPix? 
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Essential Question: How are baleen whales different than 
toothed whales?  How big are whales?  What are the names of 
some different whales? 
 
Learning Standards (State of Michigan): 
Assessed:  
English Language Arts Standard 3:Later Elementary  
Integrate listening, speaking, viewing, reading, and writing skills 
for multiple purposes and in varied contexts. An example is using 
all the language arts to prepare and present a unit project on a 
selected state or country. 
 
Mathematics Standard III.1: Elementary  
Collect and explore data through counting, measuring and 
conducting surveys and experiments. 
 
Mathematics Standard III.1: Elementary 
Present data using a variety of appropriate representations and 
explain the meaning of the data. 
 
Non-assessed: 
Science Standard I.1: Elementary 
Generate reasonable questions about the world based on 
observation. ( Key concepts: See Using Scientific Knowledge. 
Real-world contexts: See Using Scientific Knowledge.) 
 
Materials: Whales Multimedia Literature CD (by 
MacMillian/McGraw-Hill), student reproducibles, Excel, Whale 
Cards, KidPix, Internet connection 
 
Technology Connections: Students will view information about 
whales on the Whales Multimedia Literature CD.  Using that 
information, they will create a graph in Excel.  They will research 
whales on the Internet and create a KidPix slide show to share 
with the class. 
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Trainer Notes – For the purpose of Day 4 training the Whale-Animalia Lesson Plan and the 
Comparing Whales Lesson have been combined.  Trainers should follow the training steps 
are the pages preceding this lesson.   
 
Trainers should read through the lesson plan for understanding and resources. 
 
Teachers may choose to use portions of this lesson in the classroom.   
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Teaching 
Strategies 
Modeled 
 
Whole 
Group 
Instruction 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Individual 
Activity 
 
 
 
 
 
 
 
Each One, 
Teach One 
 
 
 
 
 
 
 
 
Partner 
Activity 
 
 
 
 
 
 
 
 
 

Technology 
Strategies 
Modeled 
 
Whales 
Multimedia 
Literature CD 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Spreadsheet 
 
Tips for 
Using 
Spreadsheets 
in the 
Classroom- 
http://yankee
.sburl.k12.vt.u
s/district/ite
/usingspreads
heets.htm  
 
ABC’s of 
Excel- 
http://www.m
indspring.com
/~kadkins/AB
C.htm  
 
 
 
 
 
Internet- 
http://tracks
tar.hprtec.or
g/main/displa
y.php3?option
=frames&trac
k_id=39790 

 
3-5 Procedures: 
Introduction 

1.  As a class look at the Whales Multimedia Literature CD.  
Follow the directions to create a KWL chart using the 
software.   
2.  Take students through the mural on the CD according 
to the directions that follow and add to the L column of 
your KWL chart as you learn information. 
3.  Show students the electronic version of Seymour 
Simon’s Whales on the CD.  Give each student both pages 
of the Whales fact-gathering sheet to complete with 
information they learn during the CD. 
  

Graphing Whale Size 
4. Have students take the data that they gather about 
whale size on their fact-gathering sheet and put it into a 
spreadsheet according to the directions that follow. 
5. Follow the directions to create a chart using the chart 
wizard in Excel. 
 

Researching Whales 
6. Explain that students are now going to be assigned a 
whale to learn more about.  Each pair of students will be 
responsible for teaching the rest of the class about a 
particular whale. 
7. In the morning before class, tape a whale card to the 
bottom of each student’s seat.  Make sure that you 
distribute two of each whale card.   
8. On your signal, students are to reach under their chair 
and get their whale card.  They need to find the other 
person who has the same whale.  That will be their 
assigned partner. 
9. Show students the Trackstar at 
http://trackstar.hprtec.org/main/display.php3?option=fra
mes&track_id=39790 Give each pair of students a Whale 
research sheet on which they can record facts about their 
whale. 
10. Allow pairs of students to start looking for information 
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Trainer Notes – For the purpose of Day 4 training the Whale-Animalia Lesson Plan and the 
Comparing Whales Lesson have been combined.  Trainers should follow the training steps 
are the pages preceding this lesson.   
 
Trainers should read through the lesson plan for understanding and resources. 
 
Teachers may choose to use portions of this lesson in the classroom.   
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Teaching 
Strategies 
Modeled 
 
Partner 
Activity 
 
 
 
 
 
 
 
 
 
Each One, 
Teach One 
 
Partner 
Activity 
 
 
 
Whole 
Group 
Presentation
s 

Technology 
Strategies 
Modeled 
 
 
 
Internet- 
Puzzlemaker 
 
 
 
 
 
 
KidPix Studio  

about their whale using the sites listed on the Trackstar. 
11. When they have collected enough data, they can go on 
to the final step of the Trackstar and create a word 
puzzle in Puzzlemaker using 10 whale words that they 
learned in their research. 
 

Each One, Teach One 
12. Have students work together to create a KidPix slide 
show on the Whale storyboard.  Make sure that they 
include the required elements on each slide. 
13. Show students how to copy and paste graphics from 
the Internet to use in their slide show. 
14. Follow the directions for creating your slide show. 
15. When all slide shows are complete, have students 
present their slide show to the class, teaching other 
students about their whale.   
16. While students are presenting their slide shows 
classmates will fill out the Listening Record Sheet with 
basic information about each whale. 
 

Assessment: Students will be assessed on their presentation 
using the checklist at 
http://pblchecklist.4teachers.org/view.php3?id=1847.  Their 
answers to the fact-gathering sheet and their spreadsheet will 
also be evaluated for accuracy. 
 
Extension: Have students take the information from their 
Listening Record Sheet and enter it into a whale database. 
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Whale Fact Sheet – day 4 – page 24 
 

Trainer Notes – 
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Whale Fact Sheet 
 
 
 
 
Name 3 different kinds of whales: 
 
 
 
 
How do Whales breathe? 
 
 
 
 
 
How do whales swim? 
 
 
 
 
 
What’s a fluke? 
 
 
 
 

Draw a picture of a whale: (see page 12)
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Whale Research Sheet 
Using the 5 different stations find information about your whale. Make sure you research 
all items at all stations. You may find conflicting information 
that needs to be resolved.  
 
Be sure to find out the following information: 
Baleen or Toothed: 
 
Diet: 
 
 
 
Body Size: (Adult) Length/Weight 
 
 
Population-Endangered? 
 
Habitat: 
 
 
 
 
Migration pattern: 
 
 
 
Interaction with humans: 
 
 
 
 
Other Facts (use other sheet if necessary) 
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Whales Fact-Gathering Sheet 

. 

 
      What are the two different types of whales? 
 
 
 
 
Complete the Venn diagram with information about each type of w
 

hale

 
Baleen    Toothed 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

lease list examples of each type: 
 
P
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Trainer Notes – 
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Group Fact Sheet 
 

Name of 
Whale 

Baleen 
or 

Toothed 

 
Diet 

 

Body 
Size 

Migration 
Pattern 

Human 
Interaction 

Habitat 

Sperm 

 
 
 
 
 
 

     

Beluga 

 
 
 
 
 
 

     

Sei 

 
 
 
 
 
 

     

Gray 

 
 
 
 
 
 

     

Blue 
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Comparing Whales – day 4  – page 28 
 
Trainer Notes –  
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Comparing Whales 

 

ring s 
 

 
WhaleCompa

Sei 50 

0

n

Name of Whale Length of full-
grown Adult Whale 

in feet 

Weight of full-grown 
Adult Whale in tons 

Sperm 60 50 
Beluga 30 9 

70 
Gray 90 80 
Blue 110 150 

Average 68 71.8 

 

Whale Comparison

0
20
4
60
80

100
120
140
160

Sperm Beluga Sei Gray Blue

Length of full grown
adult whale i  feet
Weight of full grown
adult whale in tons

Day 4                                                        inspiring, innovative, integration                                          Copyright  2003  i3 Inc. 
 



Curriculum and Technology Integration Training                                                  Trainers Manual  
 

Creating a Whale Graph in Excel – day 4 – page 29 
 

Trainer Notes –  
 
 
 

i3 Inc. – Inspiring Innovative Integration                                                                    Copyright  2003  i3 Inc. 



Water, Water Everywhere!                - 29 - 
Curriculum & Technology Integration Training  
   

Creatin  Excel 
 
1. Click and drag over cells A1-C1.  Click the Merge and Center button on the top toolbar.   
2. Type in the title “Comparin arged cell.  Select those words and 

change the size to 18, and click on the Bold button. 
3. In cell ds “Na In  “Length of full-

grown Adult Male in Feet”.  I grown Adult Male 
in Tons”. 

4. Click and drag over cells A2-C2 to select them.  Change the size to 12 points. 
5. With those cells selected, click on Format and Cells.  Then ck on the Alignment tab at 

the top.  Click on Wrap text under the Text Control heading.  Click OK. 
6. Select those again, and click on  center button on  top toolbar.   
7. Then size your columns to the desired width by clicking and dragging between the gray 

column hea
8. Click in cell A3.  Type in the name of the first whale.  In column A, continue to enter 

18. Print your spreadsheet.  Click on File and Print Preview.  Click on Setup, then on the 
Sheet Tab.  Click in the box beside the word gridlines to print the lines with your 
spreadsheet.  Then click on Print. 

g a Whale Graph in

g Whales” in the enl

 A2, type the wor me of Whale”.  
n cell C2, type the w

cell B2, type the words
ords “Weight of full-

cli

 cells  the  the

dings. 

the names of each whale on the fact gathering sheet. 
9. In column B, enter the length of each and in column C, enter the weight. 
10. In cell A8, type the words “Average”. Make it bold. 
11. To create a formula to average columns B & C, click in cell B8.  Then click on Insert and 

move down and click on Function.  Choose the word average from the column at the 
right and click OK.  Check to make sure that Excel has chosen the correct range for 
your average.  If not, you’ll need to click and drag to select the correct range of cells.  
Click OK.  The average will appear in the cell. 

12. Repeat step 11 for cell C8. 
13. Create your graph.  Click and drag to select cells A2-C7.  Do not include the averages in 

your selection.   
14. Click on the Chart Wizard button on the top toolbar.  It’s the one with the three 

colored bars. 
15. Choose your chart type.  Choose column graph. 
16. Click Next.  Then click Next again.  Click Next and then Finish. 
17. Your graph will now appear on your spreadsheet.  Click and drag the border of the graph 

to place it in the desired location on your spreadsheet. 

Copyright  2003  i3 Inc.                                          inspiring, innovative, integration                                                       Day 4                     
 



Curriculum and Technology Integration Training                                                  Trainers Manual  
 

• 
• 

Software Helpers – day 4 - page 30 – 39 
 

Trainer Notes – Software Helpers 
The following Software Helpers are provided for Trainer and Participants: 

KidPix 3 
Spreadsheets with Microsoft Excel 
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Software 
Helpers 
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Software Helper 
 Kid Pix 3 

Using KidPix Deluxe 3 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

hen you open up the program, the Paint Zone is revealed.  Here is an overview of the 
ools in the Paint Zone and how to use each one to create picture files. 

 
Background- Click on the Background button to see a variety of backgrounds displayed.  
Choose a category using the up and down arrows that appear under the main screen and 
then click and drag the background of your choice to the middle of the screen.  To see 
more backgrounds from within that category, click on the up and down arrows that appear 
to the right of the background selections. 
 
Stickers- Click on the Sticker button to see categories of stickers displayed.  Choose a 
category using the up and down arrows that appear under the main screen and then click 
and drag the sticker of your choice and place it on the middle of the screen.  To see more 
stickers from within that category, click on the up and down arrows that appear to the 
right of the sticker selections.  The stickers can be sized and altered using the handles 
that appear around the sticker.  The pink arrow boxes that appear in the upper left and 
lower right hand corners allow you to click and drag the graphic to size.  The other pink 
handles in the lower left and upper right hand corners allow you to change the orientation 
of the graphic.  Clicking in the center of the graphic allows you to drag and move it to 
various places on the picture. 

 

Background 

Stickers 
Animation 
Sounds 
Undo 

Draw 

Paint Bucket 

Stamps 
Moving 

Play 

nd 

Print 

Help 

Color Picker 
Slide Show 

Save 
New Picture 

Bomb 
Backgrou

Paint 

Electric Mixer 
Text Tool 

Eraser Texture 

 
W
t
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Animation- Clicking on the Anim se animated stickers to add 
to your picture.  Choose a category us n arrows that appear under the 
main screen and then click and dra f your choice and place it on 
your picture.  To see more animations from th t category, click on the up and down arrows 

ie
o
r
h
 
ic

o
a
n
is
o
o

raw- Clicking on the pencil tool brings up a set of drawing tools at the bottom of the 

d shapes. 
 The Marker Tool draws tinted lines and shapes. 

e 
t 

ation button allows you to choo
ing the up and dow

g the animated sticker o
a

that appear to the right of the animation selections.  The animations can be sized and 
w g the handles that appear around the outside of the graphic.  The  arrow 
xes that appear in the upper left and lower right hand corners allow you to click and 
ag hic to size.  The pink handle in the lower left corner plays the animation, 
il andle in the upper right hand corner allows you to stop the animation
th ter of the graphic allows you to drag and move it to various locations on your 
t

unds- Click on the Sounds button to choose a sound to add to your picture.  Choose a 
te sing the up and down arr at appear under the main screen and then click 
d drag the sound picture of your choice and place it on your picture.  To see more sounds 
played in that category, click on the up and down arrows that appear to the right of the 

und s.  Hear your sound by clicking on the Play button in the upper right hand 
rner. 

v ed by usin  pink
b
d  the grap
w e the h .  Clicking 
in e cen
p ure. 
 
S
c gory u ows th
a
d
s  selection
c
 
Undo- Click on this button to undo the last thing that you did to your picture. 
 
D
screen.   
Drawing tools from left to right: 

 The Pencil Tool draws solid lines and shapes. 
 The Chalk Tool draws smooth lines and shapes. 
 The Crayon Tool draws fuzzy lines an

 The three dots in the middle change the thickness of the line you draw. 
 The squiggly line allows you to draw freely. 
 The other tools on the left hand side allow you to draw various shapes, either open 

or filled with the selected color. 
 
To use the drawing tools, simply click and draw or click and drag on the screen.  To chang
the color, click on the large splotch in the lower left hand corner of the screen and selec
the color of your choice. 
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Paint- Clicking on the Paint button enables you to paint with the paint brush, sound art, or 

n in 

r 

e Spray Can tool allows you to spray shapes or moving paint onto your picture.  
Click on the various tools on the right hand side of the menu to choose different 

cket tools from left to right:  
 The first bucket fills an area with the selected color and 

 The second bucket fills an area with a blend of colors.  Hold down the mouse button 

 third bucket fills an area with a multicolor pattern. 
als various choices to the right of the buckets.  Use the 

up d through the different options. 
 
Ele r  transform all or part of your 
pic
Mix

ur whole picture with one mouse click. 

Clicking on each mixer reveals various choices to the right of the buckets.  Use the up and 
own arrows on the right hand side to scroll through the different options. 

 left hand side to see different stamps revealed.  Use the 
rrows on the right hand side to scroll up or down to browse the collection.  Click and drag 

spray can tools found at the bottom of the screen. 
Painting tools from left to right:  

 The Paint Brush tool allows you to add realistic and wacky 
paint to your picture.  Choose the tools displayed on the 
menu on the right to choose the style of paint.  Click on the colored shapes butto
the center to see Wacky Paint brush options.  The three dots in the center change 
the size of the line that you draw. 

 The Sound Art tool allows you to add paint to your picture using your voice and/o
the computer mouse.  Click on the various tools on the right hand side of the menu 
to choose different options. 

 Th

options and shapes. 
 
Paint Bucket- Clicking on the Paint Bucket enables you to fill areas with colors or patterns 
using the tools displayed at the bottom of the screen. 
 
Paint Bu

pattern. 

when you add colors, then move the mouse to get the blend you want. 
 The

Clicking on each paint bucket reve
an  down arrows on the right hand side to scroll 

ct ic Mixer- Clicking on this tool will enable you to
ture. 
er tools from left to right:  
 The first mixer enables you to transform yo
 The second mixer wand enables you to smudge, smear, warp, or twist your picture. 

d
 
Stamps- Clicking on this tool will allow you to add rubber stamps to your picture.  Choose a 
category from the bottom
a
on the stamp of your choice to see it displayed on the screen.  Use the three dots in the 
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center to determine the size of the stamp.  The pencil tool enables you to customize the 
sta
 
Text 
text b  to click and 
dra t  
text in
 
Te t

 Change the font, size, style, and justification using the menu in the lower left 

x.  You can 
new text box by clicking on the Paste tool to the right. 

e Copy tool.  Select the text an
be

 in your new text box. 

 

e gloved hand moves stickers, animations, and text boxes around.  Click on the 
objects to the desired location. 

our picture. 

 from the choices give on the right. 

mp and choose alternative colors. 

Tool- Click on this tool to add words to your page, then click on the page to get a 
ox for typing.  The pink handles in the corner of the text box enable you

g he text box to size.  The blue bar across the top will allow you to click and drag the
to position. 

xt ools from left to right: 
 
 

section. 
 The Scissors allows you to cut a selected text bo place the cut text in a 

d click on the Copy 
low to see the text 

 The two smiley faces indicate th
tool.  Create a new text box and click on the Paste button 
repeated

 The Speech button reads the selected words on your page out loud.  Choose the 
preferred voice from the menu to the right. 

Moving Tool- Clicking on the Moving tool enables you to 
grab, cut, and move parts of your picture around. 
 
Moving tools from left to right:  

 Th
glove and simply move the 

 The scissors enables you to cut, copy, and paste selected parts of your picture.   
Click on the scissors, then click and drag around the area you wish to select.  Use 
the Copy, Delete, and Paste tools on the right to perform the desired action.  Other 
shapes are displayed to the right that can be used to select areas of y

 
Eraser Tool- Click on the Eraser to erase all or part of your picture. 
 
Eraser Tools from left to right:  

 The mini eraser allows you to erase part of your picture by hand. 
 The big eraser clears your whole picture with one click.  Choose the way that you 

wish for your page to be erased
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C
Slide Show 

reate a New 

and Save  
 

Slide Boxes  

Saved Slide Shows Displayed Here 

Return to the 
Paint Zone 

Effects, Print, 

 
Viewer 

 

n this button to go to the slide show feature.  Before going to the slide 
how, you must have your pictur

Help- Click on this button and then 
 
Pri
 
Exi
 
Bomb-
 
Textu ol to change the paper texture.  Use the chalk, 
cra n
 
ew Picture- Click on this button to begin a new picture. 

a disk 

Deluxe 3 
Mu m  
own m
 
 
 
 

 
 
 

 

Color Picker- Click on the Color Picker to choose a color.  Click on a color swatch, or use
the eyedropper tool to pick up any color from your picture to use with the art tools. 
 
Slide Show- Click o
s es saved to a disk or your hard drive. 

click on any part of the screen that you need help with. 
 

nter- Click here to print your picture.  Choose from full page or poster printing. 

t- Click here to exit the program. 

 Click on this button, then on the screen to erase your whole picture. 

re Tool- Click on the texture to
yo , or marker to see the paper texture when you draw. 

N
 
Save- Click on this button to save your picture to or your hard drive. 
 
Creating a Slide Show in KidPix 

lti edia Slide Shows are simple to create!  Below are the directions for creating your
ultimedia wonders! 

 

 
 

Slide Show
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Steps for creating your slide show:  
1. Create all of the pictures that you wish to add to the slide show in the Paint Zone 

and save each one. 

Locate your saved picture file, click on the file name, and click Open to place the 

3. Click on the movie camera to choose the effects that you wish to include in your 
ed arrow that appears between each slide and 

choose the transition and sound that you would like to see as each slide is displayed.  
 your slide 

displayed.  Click on the OK button when you are satisfied with you choice. 

y advance.  Click on Mouse 
Click if you would like to advance the slide by clicking with the mouse.  Choosing Key 

slides using the down arrow on 
your keyboard.  Read Text Done advances the slide after all text has been read 

5. Finally, click on the speaker button under each slide to set the Audio Options.  This 
 the text, or a combination of both.  Click OK 

der your slides by clicking on the center of the thumbnail slide 
and dragging it to the desired location. 

2. Enter the Slide Show Creator.  Click on the green button under the first slide.  

slide on the slide show creator.   

slide show.   Click on the large r

Once you have made your selection, click on the Preview button to see

4. Next, click on the yellow box under each slide to choose the Page Advance options.  
Set the timer if you prefer for your slides to automaticall

Down enables you to control the progression of the 

aloud.  Click OK when you have made your selection. 

feature allows you to play sound, read
when you have made your selection. 

6. You can quickly reor

7. To save your slide show, click on the disk button and type in a file name.  After your 
file has been saved, you should see it appear in the blue menu at the bottom of the 
screen. 

8. To delete a slide or an entire slide show, click on the slide or slide show file icon at 
 bottom of the screen and drag it to the trash can. 

9. You can print a copy of the slides in your show by clicking on the print button.  You 
are given several printing options:  

 Print a full page with one slide on each page 
 Print it as a comic book with up to six slides per page 
 Print as a foldable card or booklet with up to four slides per page 
 Print a thumbnail version of the show with up to 24 slides per page

Select whether you wish the page to be portrait or landscape, then how many slides 
you wish to include in the printing command.  You can only print enough slides to fill 

e page at a time. Click OK when you are ready to proceed. 
10. To play your slide show, click on the green arrow on the right hand side. 

w with the purple splotch. 
 

the

. 

on

11. To return to the Paint Zone, click on the arro
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Software Helper 

 
Voc
 

 
a

 
Enteri
 
Ent
with y
 
Enl
click f size. 
 
Copyin
cells in which you want the data to appear.  Enter the information in the top cell and press 
Ctr
 
Edi
formu
 
AutoFill:   cell and fill in at least 
two cells he fill box 
to include ith 
consec
 
Adding the cell and choosing 
Com x.  Click on 
any  upper-right 
orner to show that the cell contains a comment.  When you place your cursor over the 

cell, you will be able to view the comment. 
 

 Spreadsheets with Microsoft Excel 

abulary: 

Workbooks- Excel files are called workbooks.  Each workbook contains three 
worksheets.  Tabs at the bottom of the screen separate them. 
Worksheets- A spreadsheet in a workbook. 
Cell- The “boxes” in a spreadsheet. 
Formula- A formula tells Excel to perform a calculation.  A formula must begin with
n equal sign. 

ng and Editing Information: 

ering Information: Click a cell to make it active.  You can move the cursor by clicking 
our mouse or with your arrows on the keyboard. 

arging Columns and Rows- Click between the column or row headings and drag.  Double-
or the column or row to automatically re

g data: If you need to enter the same data into a number of cells, select all of the 

l+Enter for windows or Code+Enter for Mac. 

ting Information: To change information in the cell, click on that cell and edit it in the 
la bar at the top. 

To automatically fill in numbers from a series, click on the
with the numbers you want entered.  Select both cells and drag down t
 the desired cells.  AutoFill will automatically fill in the selected cells w

utive numbers. 

 comments: You can set comments for each cell by selecting 
ment from the Insert box.  Enter the text for your comment in the text bo

 cell when you are finished.  The cell will not have a small red triangle in the
c
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Spell Check- You can check you d Spelling or clicking the 
check ABC button on the top to
 
AutoFormatting- Choose a pre-set autoformat by selecting the cells that you wish to 

icking on Format and Autoformat. 

Alignin y 
select lls. 
 
Background colors and patterns- Select the cells that you wish to change.  Choose Cells 
from t
 

erging Cells- To create a title for your spreadsheet or to merge two or more cells, select 
click on the merge and center button on the top 

olbar. 

 heading where you wish to have 
he cells inserted.  A row will be inserted below where you have a cell selected, and a 

orking with Worksheets 

ge the name of a worksheet, right click on 
he tab (Control + click for the Mac) and choose rename. 

ns- Freeze rows or columns when you want to see the same rows 
nd columns as you move anywhere else in your worksheet.  Move your cell pointer to the 

 sort a list based on the list’s values.  You can rearrange rows in 
scending or descending order.  Move the cell pointer to the column you want to sort.  Click 

ust begin with an equal sign.  Select the cell 
here you want to place your formula.  Start your formula with an equal sign and type in 

r spelling by clicking on Tools an
ol bar. 

format and cl
 

g Cell Contents- You can change the alignment of the information in the cells b
ing the cells that you wish to align and clicking on format and Ce

he Format menu.  Click on Patterns and choose a color. 

M
the cells that you wish to merge and 
to
 
Inserting Rows and Columns- Click on the row or column
t
column is inserted to the right of where you have a cell selected. 
 
W
 
Inserting and Renaming Worksheets- Choose Worksheet from the Insert menu and a new 
worksheet will be added to the bottom.  To chan
t
 
Freezing Rows and Colum
a
right of the column that you want to freeze and below the row that you want to freeze.  
Choose Freeze Panes from the Windows menu. 
 
Sorting a list- You can
a
the sort ascending button or the sort-descending button. 
 
Formulas 
 
Entering Formulas manually- All formulas m
w
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the formula (ex. =C1+C2+C3).  Make sure that you do not leave any spaces.  Press enter an
the formula will appear in your box. 

d 

way:  =SUM(C1:C3). 
To use the formulas built in to Excel: Click in the formula bar and type in an equal 

 that you wish to 
include or click and drag to include a range.  Press enter on your keyboard. 

nu.  
gh the Options provided to create your chart. 

o 
 the 

ox in that new window.  
lick OK and the new data will be added to your chart. 

hanging the Chart type- Activate the chart by clicking on it.  Select Chart Type from the 

hart that you want to move and 
rag it to another location. 

ew, Setup and Sheet.  Click in the box next 
o Gridlines. 

 
Using built-in formulas: There are several ways to calculate the same problem using 
formulas. =C1+C2+C3 can also be expressed this 

sign.  Click beside the formula in the box where it says SUM and choose your 
function.  The beginnings of a formula will appear.  Click on the cells

 
Charting 
 
Creating a Chart- Select the data that you want to use in your chart.  Include the labels in 
your selection.  Click on the Chart Wizard button or choose chart from the Insert me
Go throu
 
Adding new data to a chart- Enter the new data on the spreadsheet.  Click on the chart t
select it and click on Chart and Add Data.  Move the window out of the way and select
new data that you want to add.  The range will now appear in the b
C
 
C
Chart menu. 
 
Moving a Chart Element- Click on the element within the c
d
 
Printing 
 
To print Grid Lines- Click on File and Print Previ
t
 
To change the Orientation- Click on File and Page Setup.  Click Portrait or Landscape. 
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Supplemental Lesson Plans  – day 4 – page 40 - 45 
 

Trainer Notes – Supplemental Lesson Plans 
Charting Whale Migration is a supplemental lesson provided for use on this day or with 
other training.  If you are going to model this lesson, follow the step-by-step 
procedures and make use of the story boards and assessments. 
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upplemental 

  

 
 

 

S
Lesson 
Plans
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Charting Whale Migration 
Teaching 
Strategies 
Modeled 

Technology 
Strategies 
Modeled 

Instruction 
Essential Questions for achers:  How do I use e-mail in the classroom for 
peer editing?  How do I eate a time line using TimeLiner?  How do I create a 
postcard in Microsoft Word? 

Te
cr

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Essential Question: hat is migration?  Why do whales 

ning, drafting, 
or specific 
ing with peers, 

 inspiring. 

Socia r Elementary 
Explain basic ecosystem concepts and processes. 
 
Non-
Scien
Develop solutions to unfamiliar problems through reasoning, 
observation, and/or experiment. ( Key concepts: See Using 
Scientific Knowledge. Real-world contexts: See Using Scientific 
Knowledge.) 
 
Materials: Imagination Express: Ocean, student reproducibles, 
Internet connection, TimeLiner software, Microsoft Word, e-
mail access 
 
Technology Connections: Students will learn about whale 
migration using the Imagination Express: Ocean CD.  They will 
then conduct research on the Internet and create a time line.  
Finally, they will make a postcard in Microsoft Word. 
 
 
 

 
 
 
 
 
 
 
 
 

migrate?  How far does the Gray Whale migrate?  Where does it 
travel? 
 
Learning Standards (State of Michigan): 
Assessed:  
English Language Arts Standard 7: Later Elementary  

 W

Develop and use a variety of strategies for plan
revising, and editing different forms of texts f
purposes. Examples include brainstorming, revis
sensitivity to audience, and strategies appropriate for purposes, 
such as informing, persuading, entertaining, and
 

l Studies Standard II.2: Late

assessed: 
ce Standard I.1: Elementary 
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Teaching 
Strategies 
M

W
Group 
 

hole 
roup 
nstruction 

ndividual 
ork 

ndividual 
ork 

Technology 
Strategies 

 
 
 
 

magination 
xpress: 
cean 

nternet- 
ttp://www.o

odeled 
 

hole 

Modeled Express: Ocean.  To access the information, open the program.  
Sign in and click on the Fact Book.  Click on Animal Migration.  
Read the information to s

 
 
 
 
 
 
 
W
G
I
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
I
W
 
 
 
 
 
I
W
 
 
 
 
 
 
 
 
 
 
 

 
I
E
O
 
 
 
 
 
 
I
h
cregister.com
/science/feat
ures/seaview
/whales/migr
ation/new_mi
gration_shock
.s
S
C
 
 
 
 
 
 
T
T
T
h
omsnyder.com
/classroom/ti
melineronline
/
 
 
 
 
M
W
 
E
 

 
Charting Grey Whale Migration: 
1. Give 

/migration/new_migration_shock.shtml.  Show this site on the 
erter for all students to see.  Look at the map on 

y 

e 
e 

heir 
paper.  Then enter February 1 and so on, until you get to 

rthern Coast 

. Now, take that information and create a time line using 
tware.  Follow the directions for creating your 

int his/her time line. 

 
 a postcard to his friends “back home”.  Include 

information about his current location and other relevant 

 in Microsoft Word. 
. Have students e-mail their completed postcards to a peer for 

o the 

e 

. Have students fill out a self-assessment of their completed 
postcard. 

scan conv
the site and have them chart the migration of the Gre
Whale on their map with a red crayon or marker. 

2. As a group, write positional clues that describe where th
Grey Whale can be found each month using the locator on th
site.  Simply change the month and the day.  Begin with 
January 1 and have students record it in the chart on t

December 1.  For example: January 1, Off the No
of Canada. 

3
TimeLiner sof
time line.  Allow each student to pr

 
Postcard Home 
4. Have students pretend that they are Grey Whales.  Ask them

to create

facts. 
5. Follow the directions to demonstrate how to create a 

postcard
6

editing. Ask the peer to make any comments and reply t
e-mail. 

7. Show students how to print their postcards and display in th
room. 

8

html 
can 
onverter 

imeLiner 
imeLiner 
eacher Tips- 
ttp://www.t

tt.html  

icrosoft 
ord 

-mail 

 

3
Introduce the students to Whale migration with Imagination 

tudents.  Then click on the movie 
camera to see animation.  Click on the Stop sign to exit. 

each student a copy of the map.  Go to 
http://www.ocregister.com/science/features/seaview/whales

-5 Procedures: 
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Teaching 

 
echnology 

sing E-mail 
 the 
anguage 
rts 
lassroom- 

Strategies
Modeled 

T
Strategies 
Modeled  
 
U
in
L
A
C
http://www.t
echlearning.co
m/db_area/a
rchives/WCE
/archives/chu
c

 
Assessment: Stud
postcards using a rubric. 
 
Extension: Have student’s research the migratory patterns of
another whale and compare it to that of the Grey Whale. 
 
 
 
 

 

 

 
 
 
 

k.htm  

ents will be assessed on their completed 
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Charting the Migration of the Grey Whale 

Date Where they will be… 
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Creating your Migration Time Line 
 

1. Open TimeLiner program. 
2. Click on New.  Then click on Floating. 
3. Double-click on the word Monthly, then on OK. 
4. Begin to enter your information in the boxes.  Hit the enter key on your 

keyboard to create a new entry.  
5. Click on View and Banner.   
6. To change the font size, click on Edit and Select all Events.  Then click on Format 

and Set Event Font.  Change the size to 14 point. 
7. To size the event flags, click on the flag to select it, then click on the black box 

to the right of the flag.   
8. To move your flags around, click and drag them to the desired location.  
9. To change the look of your flags, click on the flag to select it.  Then click on the 

grayed section to the left of the flag and choose a style
10.  Change those events in which the whales are traveling south to black flags. 

Leave those in which the whales are traveling north white. 
11. Print your time line. 

 
 

. 
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Brain Check  – page 50 
 
Trainers Notes – Brain Check 
The Brain Check should be adapted by each Trainer to match the selected software 
used in the training. 
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1. N p guide our research on whales? 
 
 
 
2. H
 
 
 
 
3.  Nam
 
 
 

4.  I can import almost any picture into KidPix.  True/False 
 
 
 
 
5.  How do you save an attachment to your computer from an email? 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

ame the 2 Web based tools that hel

ow do you select multiple cells in MS Excel? 

e 3 of the tools in KidPix? 
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Daily Closure  
 

Trainer Notes –  
• Recap the day.  
• Take questions that participants have.  
• Assign Homework 
• Have participants straighten up their area. 
• Shut down computers 
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